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Keyboard

The keyboard functions essentially the same as for any windows application.    The only 
unique feature of the keyboard interface involves selecting items and launching applications.
Use the arrow keys to move from item to item.    Hitting return will execute the selected item.
Note that you may select multiple items by using the mouse only.

Items may also be selected by hitting the first letter of the item's name.    Repeatedly hitting 
a letter will move you through all item's whose names begin with this letter.    This interface 
will work only in icon display mode.



Sloop Manager Commands

To get help with a command, choose the appropriate menu.

File Menu
    New
    Open
    Save
    Run
    Exit

Edit Menu
    Add item
    Delete item
    Delete file and item
    Delete subfolder
    Move
    Copy
    Properties
    Item icon

Special Menu
    Set default icon
    Arrange icons
    Associate
    Preferences
    Edit run menu (main Sloop Manager window only)
    Global options (main Sloop Manager window only)

Run Menu
    Popup run menu



Sloop Manager Procedures

The Procedure topics give you detailed instructions on using the commands available to a 
folder.

Working with folder items
Adding items to a folder
Changing an item's icon
Changing an item's name
Changing the properties of an item
Copying items from folder to folder
Deleting a folder item
Deleting a folder's item and its file
Editing/viewing an item's file name
Executing an item
Moving items from folder to folder
Setting an item's command line
Setting the default icon

Other
Associating programs with file extensions
Creating a new folder
Editing the popup run menu
Exiting a folder
Global options settings
Opening a folder
Saving a folderSetting the folder icon
Setting the password
Using the browse button
Using the CommandBar
Using the Preferences command
Using the Run command



File Menu

New - This command create a new folder.    Note that you can create subfolders in subfolders
with essentially no limit on nesting folders within folders.    Be sure and give each folder an 
unique name.    Changing the case of a letter will not make a name unique.

Open - This command allows you to open or activate, if already open, any folder on the 
system, regardless of its location .    This allows you to open a specific folder without having 
to hunt it up.

Save - This command saves any changes made to the folder.    Note that some commands 
will automatically perform a save when executed.    They include delete subfolder, rename a 
subfolder, create a subfolder.      The current configuration of a folder may also be saved 
using this command.    The configuration includes the size of the folder, the position of the 
folder and the location of the items in the folder.    Exactly which of these quantities are 
saved can be set using the Preferences command under the Special menu.

Run - Allows the user to enter a command line to be executed.    The last twelve commands 
entered are stored for easy access.

Exit - Causes the current folder to be closed.    If has not been saved, and changes have 
been made, you will be prompted on whether or not you want the folder saved.



Edit Menu

Add Item - Adds items to the current folder.    A dialog box is presented from which you may 
choose any file on the system.    After choosing, a descriptive name for the item must be 
entered.    This is the name that will show up under the item's icon.    An icon will then appear
which represents the item just added.    By double-clicking on this icon, the item may be 
executed.    Multiple items may be added by clicking on each file in the file listbox you wish 
to add.    Clicking on a selected file will de-select it.

Delete -
Item - This command removes the selected item from the folder.    It does not delete the 
file associated with the item.    It simply removes it from the folder.    If multiple items have 
been selected, a prompt to delete or not appears for each item selected.

File and Item - This command removes the item from the folder and deletes the file 
associated with the item.    As such, use it only when you wish to remove the file 
completely from the disk.    If you wish to only remove the item from the folder, use the 
Delete Item command.    This command does not function with subfolders.    If multiple 
items have been selected, a prompt will appear as to whether or not to delete it for each 
item selected.

Subfolder - Use this command to delete a subfolder.    Note that this command 
completely removes the subfolder.    As such, if you have copied it to another folder and 
wish to be able to still access it from this other folder, use the Delete Item command to 
remove it from the current folder rather than this command.    Also, any subfolders in this 
subfolder are NOT deleted.    So be sure and delete these other subfolders, first.

Move - This command moves the currently selected item to the folder specified.    In doing 
so, it is removed from the current folder.    Note that if the folder you are moving the item to 
is open, it must be closed and reopened before the new item will appear.    This commands 
will work on any item including subfolders.    If multiple items are selected, all items selected 
are moved.    Items may also be moved by dragging them with the mouse to the desired 
folder, which must also be open.

Copy - Works the same as move, but does not remove the item from the current folder.    If 
multiple items are selected, all items selected are copied.    Use this command to link two or 
more folders to the same subfolder.    Simply create the desired subfolder using the File 
menu New command.    Then copy the new folder item to whatever other folders you wish to 
be able to access it.    Items may also be copied by dragging them with the mouse to the 
desired folder.    The right mouse button must be held down when releasing to left mouse 
button for the items to be copied, otherwise they will be moved.

Properties - This command displays and allows you to edit all the properties associated 
with an item.    These properties include the item's descriptive name, its filename, its 
command line, its working directory and its icon.    To edit a property, simply type in the new 
property in the appropriate edit field.    To change the item's icon, click on the icon button 
provided and choose the new icon using the icon browser dialog which appears.    Two 
checkboxes are provided to allow the item to be run minimized or maximized on execution.   
Check whichever option you desire or leave them unchecked for the item to run in a normal 
window.

Item Icon - Allows you to specify which icon is to be used to represent an item.    Icons may 
be used located in ICO files, EXE files or ICL files (icon libraries).    This command is the same 
as that provided by using the Properties command described above and selecting the icon 



button.    It is provided simply so you do not have to go thru the Properties command to 
change the icon.



Special Menu

Set Default Icon - This command allows you to associate an icon with a file extension.    
Doing so, will cause the specified icon to be used to display any item with that particular 
extension unless the item's icon has been set with the Item Icon command.    The new 
associations will not appear until the folder is closed and reopened.    This is true for any 
folder that was open when the changes were made.    Once set, any item with the specified 
extension will appear using the icon associated with that extension.

Arrange Icons - Arranges the folder icons in an orderly manner.

Associate - The associate command is similar to the Associate command in File Manager.    
It can be used to associate a particular program with a specified file extension.    Whenever 
you execute an item the program associated with the item's file extension will be run using 
the item as the data file.    Unlike the File Manager's command, multiple programs may be 
assigned to a single extension.    Executing an item with multiple programs assigned to it will
cause a listbox to appear from which the desired program to be run may be chosen.

Preferences - This command allow the folder to be customized.    What aspects of a folder 
that are saved when using the Save Config command may be set from this command.    Also,
the folder can be set to minimize or close on execution of an item in the folder.    Auto 
arrange of icons can be turned on or off from this command.    Note that if auto arrange is on,
the icons will be re-arranged everytime the folder is resized or minimized so it is 
recommended it be turned off if saving item positions.    Finally, the display mode to be used,
icons or listbox may be set from this command and a password may be assigned to the 
folder by using the Password button.

Edit run menu - (available only from the main Sloop Manager window) This command 
allows you to modify the customizable popup run menu.

Global Options - (available only from the main Sloop Manager window) This command 
allows various global options to be set.    These include turning on and off the confirmation of
deletes and saves.    If either is turned off, the operation will be performed without 
requesting confirmation from the user.    Also, Sloop Manager startup options may be set.    
Sloop Manager may be set to always start as an icon or as a normal window.    In addition, a 
reopen folders on startup option is available.    Selecting it will cause any folders which were 
opened on exiting Windows to be reopened on Windows startup automatically.    Finally, the 
preference settings given to any new folder upon creation may be set from this command.



Run Menu

Displays the popup run menu to allow you to make a selection from it for execution.



Customer Support

Customer support is available to all registered users of Sloop Manager for as long as you 
own the program.    Support is also available to unregistered users during their thirty day 
trial period.

Support may be obtained by calling (719) 260-0433 during normal business hours.    Please 
leave a message should we be unable to answer the call immediately.    We promise to get 
back to you that same day if at all possible.

You may also write us at:

Sloop Software
Customer Support
6457 Mesedge Lane
Colorado Springs, CO 80919 USA

Or by sending email to CompuServe (id 72540,144) or Internet (id 
72540.144@compuserve.com) or America Online (id Sloop Soft).    We check CompuServe on
a daily basis allowing for a prompt response to any inquiries.

Please include as many details as possible concerning any problem you may be experiencing
to allow us to fix it as quickly as possible.

This program is produced by a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the shareware principle works for you.    If you are unable to 
resolve a shareware-related problem    with an ASP member by contacting the member 
directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 or 
send a CompuServe message via CompuServe Mail to ASP Ombudsman, 70007,3536.



Registering Sloop Manager

See the README.TXT or the SLOOPMAN.WRI files for information on registering Sloop 
Manager.    Registering gets you the latest version and a printed manual, if desired.



License Agreement

No part of this manual may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language (natural or binary), in any form or by any means, 
except as described in the following license agreement or without the express prior written 
consent of Sloop Software.
                                                      
The use of Sloop Manager is subject to the following terms and conditions.

Title To The Licensed Software
Title to the licensed software is NOT transferred to the end user. The end user is granted an 
exclusive license to use the software on a SINGLE computer or computer work station. EACH 
computer or computer work station must have its own licensed copy of the software.

Copyright Protection
Sloop Manager is copyrighted material. It is protected by the copyright laws of the United 
States, the State of Colorado, and other proprietary rights of Sloop Software. You may not 
make any changes or modifications to Sloop Manager or this manual. You may not 
decompile, disassemble, or otherwise reverse-engineer the software in any way.

You may make copies of Sloop Manager only under the terms of the section entitled "Limited
License To Copy The Licensed Software".

You may use Sloop Manager on a trial basis provided you do not violate the protection 
afforded the licensed software by the copyright laws, and you agree to the terms of the 
license agreement. If you use Sloop Manager on a regular basis you are obligated to 
purchase it.

Limited Warranty
Sloop Software does not warrant that the licensed software will meet your requirements or 
that the operation of the software will be uninterrupted or error free.    The warranty does not
cover any media or documentation which has been subjected to damage or abuse by you.

The software warranty does not cover any copy of the licensed software which has been 
altered or changed in any way.

ANY IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE ARE LIMITED TO THE TERM OF THE EXPRESS WARRANTIES. 
Some states do not allow limitations on how long an implied warranty lasts, so the above 
limitation may not apply to you.

Other Warranties
The warranties set forth above are in lieu of any and all other express or implied warranties, 
whether oral, written, or implied, and the remedies set forth above are the sole and 
exclusive remedies.

Limitation Of Liability
Sloop Software is not responsible for any problems or damage caused by the licensed 
software that may result from using the licensed software. This includes, but is not limited 
to, computer hardware, computer software, operating systems, and any computer or 
computing accessories. End user agrees to hold Sloop Software harmless for any problems 
arising from the use of the software.

Sloop Software SHALL NOT IN ANY CASE BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 



CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM ANY BREACH OF 
THESE WARRANTIES EVEN IF Sloop Software OR ITS AGENTS OR DISTRIBUTORS HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    Some states do not allow the exclusion 
or limitation of incidental or consequential damages, so the above limitation or exclusion 
may not apply to you.

In no case shall Sloop Software's liability exceed the license fees paid for the right to use the
licensed software, or a sum no greater than one Dollar ($1.00), whichever is less.

Limited License To Copy The Software
You are granted a limited license to copy Sloop Manager ONLY FOR THE TRIAL USE OF 
OTHERS subject to the terms of this software license agreement described herein, and the 
conditions described below are met:    Sloop Manager MUST be copied in an unmodified form 
and SLOOPMAN.ZIP MUST contain the following files:

          SLOOPMAN.EXE - the Windows executable program (shareware version only)
          SLOOPMAN.WRI - the program documentation
          README.TXT - installation information
          SLPMAN.INI - Sloop Manager initialization file for manual install
          SLOOPMAN.HLP - Sloop Manager help file
          SLOOPMAN.FL1 - used for manual install
          INSTALL.EXE - Sloop Manager install program
          METER.DLL - install link library
          SETUP.INF - install setup information
          SLOOPMAN.ICL - Sloop Manager icon library
          TROUBLE.TXT - troubleshooting information
          BWCC.DLL - link library used by program
          SMTOOLS.DLL - link library used by command bar
          GRPCONV.EXE - group conversion utility
          SMTRASH.EXE - trashcan utility
          ORDERFRM.TXT - Sloop Manager order form
          VENDOR.DOC - shareware vendor information

-> No fee, charge or other compensation may be accepted or requested by anyone without 
the express written permission of Sloop Software.

Public Domain Disk Vendors May NOT CHARGE a fee for Sloop Manager itself. However you 
may include Sloop Manager on a diskette for which you charge a nominal distribution fee. 
The purchaser of said diskette must be informed in advance that the fee paid to acquire the 
diskette does NOT relieve said purchaser from paying the registration fee for Sloop Manager 
if said purchaser uses Sloop Manager.

-> Operators of electronic bulletin board systems (Sysops) may post Sloop Manager for 
downloading by their users without written permission ONLY AS LONG AS THE ABOVE 
CONDITIONS ARE MET.    A fee may be charged for access to the BBS AS LONG AS NO 
SPECIFIC FEE IS CHARGED FOR DOWNLOADING Sloop Manager files without first obtaining 
express written permission from Sloop Software to charge such a fee.

The above constitutes the license agreement for Sloop Manager.    It supersedes any and all 
previous license agreements.



Notes on using icons

Sloop Manager allows you to use icons present in ICO files, EXE files, DLL files and ICL files.    
ICO files contain a single icon, while EXE's, DLL's and ICL files may contain one or more icons
that may be used.    An icon library, sloopman.icl, is included with the program for your use.   
To use it, simply copy it to the Sloop Manager data directory.    Everytime you use the Item 
Icon, or Set Default Icon command, the icon dialog box will initially present all the icons in 
the sloopman.icl for you to choose from.    If the icon you wish to use is not present, simply 
select the file which does have the desired icon and hit Read.    Note that you may basically 
do anything you wish with the sloopman.icl file without impacting Sloop Manager operation.  
It may be deleted, copied over or edited with a program such as Icon Manager or equivalent. 
If it is not present, you will simply not have any icons to choose from initially on executing an
icon command.

Hierarchy of icons:    There is a hierarchy involved in Sloop Manager deciding which icon 
should be used to represent an item.    At the top-level, if an item has had an icon explicitly 
set for it using the Item Icon command, this icon will always be used regardless of any other 
settings made.    Next, if the item does not have an icon set for it, but does have an icon 
associated with its extension, this icon will be used.    Finally, if neither of the above is true, if
the item is an executable or is associated with an executable, the icon for that executable 
will be used.    If none of the above holds, the item will appear using the default icon, which 
is the DOS icon.

Limitations: There may be cases where, for some reason, Sloop Manager just cannot find the
icon in the specified file.    In order to use such an icon, you will need to convert it into an ICO
file using some utility such as Icon Manager.    Once this is done, simple specify the ICO file 
created to use the icon.

Troubleshooting: Should you be using a 256 or 32000 color display and the icons are not 
displaying correctly, try this fix.    In the SLOOPMAN.INI file, under [Defaults] should be a line 
that reads 'Color Mode=0'.    Change the 0 to 256 or 32000.    This should allow the icons to 
display correctly.    Note that Sloop Manager will only work in 256 or 32000 mode now.    To 
run in 16 color mode, change the number to 16 or 0, for auto-sensing of the color mode.    If 
your INI does not have the color mode line, simply add it in to the [Defaults] section.

Related Topics
      Changing an item's icon
      Setting the default icon



Group Conversion Utility

The group conversion utility is provided to allow you to convert Program Manager groups to 
Sloop Manager folders.    This may be necessary at times, specifically after installing a new 
program into Windows.    While a communication link similar to that used by Program 
Manager is incorporated into Sloop Manager, some install programs will install only into 
Program Manager.    If you should install such a program, through the use of the group 
conversion utility the new group created by the install program may be imported into Sloop 
Manager.

To make use of the group conversion utility, follow the steps given below.

1. Run grpconv.exe from Windows.    This file is initially placed in your sloopman data 
directory, but may be moved to any location desired.

2. From the dialog that appears, choose the group to be converted and enter the name for 
the Sloop Manager folder.    Click on OK.

3. Once the conversion process is complete, exit and restart Sloop Manager.    Do not save 
Sloop Manager before exiting.    If using Sloop Manager as the Windows shell, it will be 
necessary to exit and restart Windows.    Note that multiple groups may be converted before 
exiting by repeating these steps.

Once Sloop Manager has been restarted, there should be a new folder in the main Sloop 
Manager window containing items equivalent to the items in the Program Manager    group.



Trashcan Utility
A trashcan program is provided for disposing of folder items.    To use the program, execute 
the file smtrash.exe.    This file is initially placed in your sloopman data directory.    Once 
executed a trashcan icon will appear on the desktop.

To delete an item from a folder, simply drag the item to the trashcan.    Multiple items may 
dragged and dropped..    

Should you wish to recover a deleted item, double-click on the trashcan icon.    It will open 
into a window showing all the items that have been dumped into it during the current 
Windows session.    These items may be dragged out of the trashcan and dropped into a 
folder to recover them.

The trashcan will automatically empty whenever it is terminated.    The trashcan may also be
emptied by executing the Empty Trash command under the Trashcan File menu.    Finally, the
can will automatically empty when the number of items in it exceed forty.

Important note: Dragging an item into the trashcan is equivalent to the Delete Item 
command under the Sloop Manager Edit menu.    It does not delete the item's file from the 
disk.    Also, folders may not be deleted using the trashcan.    The delete commands under 
the Edit menu must be used to delete folders.



Using the browse button

Both the Run command and the Associate provide browse buttons to allow you to select a 
file to be run or associated.    To use the browse button, simply click on it.    A browse dialog 
essentially identical to the dialog used by the Add Item command is provided.    Find the file 
in the file listbox you wish to make use of and click on it.    The current directory may be 
changed using the directory listbox on the right.    Once you have selected a file, click on OK 
and it will appear in the dialog box of the command being executed (Run or Associate).



Using the CommandBar

A push button command bar is provided for quick access to various main menu commands.   
Buttons are provided for accessing the New, Open, Save, Add item, Properties and Item icon 
commands.    Clicking on the appropriate button is equivalent to executing that menu 
command.    In addition, by clicking anywhere on the CommandBar itself, the popup run 
menu may be accessed.

The CommandBar may be turned off from an option in the Global Options dialog.    An info 
bar is provided as well as the CommandBar.    The InfoBar displays the actual file name and 
size of the currently selected folder item.    A -1 for the file size indicates that the file path 
information is incorrect.    Like the CommandBar, the InfoBar may be turned off from the 
Global Options dialog.

Note that by clicking on the InfoBar the Preferences dialog may be brought up.



Using the Preferences command

1. Select Preferences from the Special menu.

2. From the dialog box presented, several options may be set to customize the folder as 
explained below.

Save Configuration options: When executing a Save command, the choses selected 
here will govern what information about the folder is saved.    Information that can be 
saved include the folder size and position, and the position of the folder items.    Any 
option not selected will not be saved.    Note that by de-selecting the folder position 
option, the folder will be free to appear anywhere on the desktop.

Minimize on use, Close on use options: Selecting one of these will cause the folder to 
be either minimized or closed when an item in the folder is executed.

Auto Arrange switch: When this option is activated, the folder item icons will 
automatically be rearranged whenever the folder is resized or minimized.    If you wish 
to keep the folder items in specific locations at all times, do not use this option.

Icons off: This option, when set, will cause the folder items to be displayed using only 
their names.    No icons will be displayed.    This mode is the listbox display mode.    If 
this option is not set, all items will be displayed using icons.

Show extensions: When in listbox display mode, the item file extensions will be 
displayed as part of the name if this option is set.

3. Once you have chosen the options you with to be active for this folder, click on OK to 
return to the folder window.    Note that a Save or a Save Config must be performed for the 
preferences to be saved.

4. Finally, a password may be assigned to the folder thru the use of the Password button.    
Clicking on it will produce a dialog box in which you may enter the desired password for this 
folder.    The next time the folder is opened, this password will need to be entered before you
will be able to access the folder.    To clear the password, simple select this function again 
and enter a blank line for the password.



Adding items to a folder

1. Select Add Item from the Edit menu.

2. From the dialog box that appears, choose the file you wish to add.    Multiple files may be 
selected by simply clicking on each file to be added.    To deselect a file, click on it again.    
Use the directory list box on the right to change directories.    All highlighted files will be 
added.    Click on OK.    Note that files may be added from a single directory only.

3. Enter the descriptive name for each item that you wish to have appear under the item 
icon.    Hitting the Cancel button at this point will cause the current item not to be added.    
Any other items selected will still be added.    Note that by double-clicking on the File: field of
the dialog, you may display the actual file name of the item with its extension.

4. The new item(s) should now appear as an icon in the folder.



Changing an item's icon

1.    Select the item whose icon you want to change    by clicking on it with the mouse.

2.    Select Item Icon from the Edit menu.    The icon browser dialog will appear.

3.    From the dialog box, choose the new icon to be used to represent the selected item.    To 
use an icon in a specific file, select the file using the file listbox by clicking on the file to be 
read.    The current directory may also be changed from this listbox.    Use the radio buttons 
to select the files to be displayed.    Click on Read to display all icons in the selected file.    In 
the icon listbox, select the desired icon and click on OK.

4.    The item should appear with the new icon.

Related Topics
      Notes on using icons
      Properties command
    Setting the default icon



Changing the properties of an item

1. Select the item whose properties are to be viewed or edited by clicking on it with the 
mouse.    Select the Properties command from the edit menu.

2. The item name, file name, command line and working directory may be edited by 
changing the value in the appropriate edit field.    Click on OK to save the settings.    Note 
that by entering a blank line for the command line or working directory, the default 
functionality of the item will be restored.    Also, by entering 'Current directory' (no quotes) 
the directory will not be changed when executing that item.

3. The item icon may be set by clicking on the icon button provided.    Doing so will bring up 
the icon browser dialog from which the new icon may be selected.

4. Finally, the item may be set to run minimized or maximized by clicking on the appropriate 
check box.

Related topics
Changing an item's icon



Copying items from folder to folder

1.    Select the item you wish to copy by clicking on it with the mouse.    Multiple items may 
be selected by holding down the CTRL key while clicking on each item.
2.    Select Copy from the Edit menu.
3.    From the dialog box, select the folder you want the item(s) copied to.    Click on OK.
4.    The item(s) will now be copied to the specified folder.

or

1. Make sure the folder you wish to copy the selected items to is open or is a subfolder of the
current folder.
2. Select the items to be copied in the same manner as above, but on the last item selected 
continue to hold down the left mouse button.
3. Drag the cursor to the folder you wish to copy the items to.    The cursor will be a 
monochrome version of the selected item if only a single item is selected.    If multiple items 
are selected, it will be a generic drag item cursor.
4. While holding down the right mouse button, release the left mouse button while the 
cursor is over the folder you want to copy the items to.    If the cursor is a circle with a line 
across it, you are over an illegal drop point.
5. Once the left mouse button has been release, the right mouse button may also be 
released.    The selected items will be copied to the specified folder.

Using this command, one can link the same subfolder to two or more other folders.    Simply 
copy the subfolder to the folder you wish to also have access to it.

Related Topics
    Moving items from folder to folder



Creating a new folder

1.    Select New from the File menu.

2.    Enter the name of the new folder.    This name MUST be unique.    Upper or lower case do 
not make any difference.    Click on OK.

3.    A new folder icon representing the new folder should appear in the current folder.

Related Topics
      Deleting a subfolder



Deleting an item

1.    Select the item you wish to delete by clicking on it with the mouse.    Multiple items may 
be selected for deletion by holding down the CTRL key while clicking on each item to be 
deleted.

2.    Select Delete Item from the Edit menu.

3.    You will be asked if you wish to delete the selected item.    Click on Yes or No.

4.    If you clicked on Yes, the item will be deleted from the folder.    Note that if you 
accidentally delete an item, close the folder without saving it.    When you reopen it, the item
will still be there.

Related Topics
    Deleting an item and its file
      Deleting a subfolder



Deleting an item and its file

1.    Select the item you wish to delete by clicking on it with the mouse.    Multiple items may 
be selected for deletion by holding down the CTRL key while clicking on each item to be 
deleted.

2.    Select Delete File and Item from the Edit menu.

3.    You will be asked if you want to delete the selected item and its file.    Click on Yes or No.

4.    If you clicked on Yes, the item will be removed from the folder and the item's associated 
file will be erased from the disk.

Related Topics
      Deleting an item
      Deleting a subfolder



Deleting a subfolder

1.    Select the subfolder you wish to delete by clicking on it with the mouse.

2.    Select Delete Subfolder from the Edit menu.

3.    You will be asked if you want to delete this subfolder.    Click on Yes or No.

4.    If you clicked on Yes, the subfolder will be removed from the system.    Note that if the 
subfolder has been copied to other folders, it must be removed from those folders using the 
Delete Item command.

Note that any subfolders contained in the subfolder being deleted will NOT be deleted.    
They should be removed thru use of this command before deleting the subfolder they are 
contained within.

Related Topics
        Deleting an item
        Deleting an item and its file



Editing the run menu

A customizable popup run menu is provided from which programs may be run.      A menu 
editor dialog is supplied to build and maintain this popup menu.    It may be accessed by 
selecting    the Edit run menu command under the menu command Special.    It may be used 
to add items, including separators and submenus, to update item command lines or to 
delete items from the run menu. 

Adding run menu items:
1.    Select the item from the menu listbox you wish the new item to appear under.    By 
selecting the ---- Top of Menu ---- place holder a new item may be added at the top of the 
menu.

2.    Select the radio button corresponding to the type of item you wish to add.    The new 
item may be a separator bar, a submenu of the current menu or just a normal, executable 
menu item.

3.    Fill in the name for the new item and its corresponding command line.    The Browse 
button will bring up a dialog which may be used to select a file for the command line.    Note 
that the command line field should not be modified for separator and submenu item types.

4.    Click on the Add button and the new item will be added to the run menu.

Changing an item's command line:
1.    Select the item from the menu list box whose command line you wish to change.

2.    Type in the new command line.    Click on the Add button.

3.    The item's command line will be updated to the new command line.    Note that the Add 
button is used both to add new items and to modify the command line of old items.

Deleting an item:
1.    Select the item from the menu listbox you wish to remove from the run menu. 

2.    Click on the Delete button and the item will be removed from the menu.

Creating submenus:
1.    Add a new item for which you have selected the Submenu radio button for the item type.
Be sure not to modify the command line when adding the item.    Only the name for the 
submenu needs to be specified.

2.    Select the newly added submenu item.    The >>> button will now be enabled.    Clicking 
on this button will allow you to build the menu to be associated with the submenu item 
added in step 1.

3.    To return to the parent menu, click on the <<< button.    You may have as many 
submenus as you desire and the submenus may have submenus of their own.    They may be
edited in the exact same manner as the main parent menu.

Once you have made all the desired changes to the run menu, click on the Done button to 
exit the dialog.    The newly edited popup run menu will now be accessible from the main 
menu Run command or by clicking on the CommandBar with the left mouse button.



Executing an item

1.    Double-click on an item's icon to execute it.
                  or
2.    Click on it with the mouse and hit the enter key.
                  or
3.    Use the arrow keys to select the item.    Hit    the enter key.



Exiting a folder

1.    Select Exit from the File menu or Close from the System menu.

2.    If changes have been made to the folder since the last save, you will be prompted for 
whether or not you wish to save the folder.    Clicking on Yes will save and exit the folder.    
Clicking on No will exit the folder without saving.    Clicking on Cancel will cancel the exit 
operation and return you to the folder.



Global options settings

Various global options may be set using the Global Options command found under the 
Special menu of the main Sloop Manager window.    These options include:

Confirmation settings:
Confirm on delete - checking this box will cause a confirmation box to be presented for 
the user to confirm the delete.    If not checked, the delete will occur automatically.

Confirm save on exit - normally upon exiting a folder you are presented with the option of 
saving any changes that have been made to the folder.    If this option is unchecked, the 
save will be performed automatically upon exit.

Confirm Windows exit - this option controls whether or not to confirm exiting Windows.

Startup settings:
Start SM minimized - checking this box will cause Sloop Manager to always start as an 
icon on the desktop.

Start SM normal - this option will cause Sloop Manager to always start as a normal 
window.    Normally, it is not necessary to check this box for SM to start in a normal 
window.

Reopen folders - checking this option will cause any folders which were open at the time 
Windows was exited to be reopened on Windows startup.    Note that the folders will not 
necessarily be opened in the same position or size they were in when Windows was 
exited.

New folder settings:
All of the options provided under the New Folder Settings heading are used to set the 
preferences any new folder will be created with.    These settings are used only when a 
new folder is created and once the folder has been created, its preferences settings may 
be changed using the Preferences command.

Folder icon:
Finally, by clicking on the folder icon button, the icon to be used to represent folders may 
be set.    Upon clicking on the folder icon button, the icon browser dialog will be presented
to allow you to select the desired icon.    See the section on changing an item's icon for a 
description on how to use the icon browser dialog.    Once an icon has been selected, all 
folder icons will be changed to the selected icon.

Related topics
    Changing an item's icon
    Using the Preferences command



Moving items from folder to folder

1.    Select the item you wish to move by clicking on it with the mouse.    Multiple items may 
be selected by holding down the CTRL key while clicking on each item.
2.    Select Move from the Edit menu.
3.    From the dialog box, select the folder you want the item(s) moved to.    Click on OK.
4.    The item(s) will now be moved to the specified folder.

or

1. Make sure the folder you wish to move the selected items to is open or is a subfolder of 
the current folder.
2. Select the items to be moved in the same manner as above, but on the last item selected 
continue to hold down the left mouse button.
3. Drag the cursor to the folder you wish to move the items to.    The cursor will be a 
monochrome version of the selected item if only a single item is selected.    If multiple items 
are selected, it will be a generic drag item cursor.
4. Release the left mouse button while the cursor is over the folder you want to move the 
items to.    If the cursor is a circle with a line across it, you are over an illegal drop point.    
The selected items will be moved to the specified folder.

Related Topics
    Copying items from folder to folder



Opening a folder

1.    Select Open from the File menu.

2.    Choose the folder you wish to have opened from the list in the dialog box.    Click on OK
.
3.    If the folder selected has not been previously open, it will be opened and appear in a 
second window.    If it is already open, it will be made the active window.    If is already open 
and minimized, its icon will be opened into the active window.



Saving a folder

1.    Select Save from the File menu.

2.    All change made to the folder will be saved.      In order to save a folder's size or position, 
or the position of the items in the folder, a Save must be executed and the appropriate 
option must be selected in the Preferences dialog.    The exact information saved is 
determined by the options selected using the Preferences command.

Related Topics
      Using the Preferences command



Setting a default icon

1.    Select the item whose file extension you wish to assign a default icon to.

2.    Select Set Default Icon from the Special menu.

3.    Choose the icon you want associated with the extension from the icon listbox presented. 
To use an icon in a specific file, select the file in the file listbox and click on Read.    From the 
icons presented, select the desired icon.

4.    To see the new icons, close and reopen the folder.

Note that these associations will apply to all folders, not just the one they are set in.    To 
remove any association previously set the SLOOPMAN.INI file must be edited.    Open it with 
a text editor like Notepad.    Under the section [Icon Extensions] delete the line containing 
the extension you wish to de-associate.    Save the file.    The items should now appear using 
their old icons.    To clear all default icons assigned, simply delete the file SLOOPMAN.DFI in 
your folders data directory.

Related Topics
      Changing an item's icon



Setting the folder icon

This procedure may only be performed from the Sloop Manager window.

1. Select the Global Options command from the Special menu.

2. Click on the Folder Icon button.

3. From the icon browse box select the icon to be used as the folder item icon.    Click on OK.

4. All subfolders and minimized folders will now appear using the selected icon.

Related Topic
      Changing an item's icon



Setting the password

1. Select the Preferences command from the Special menu.

2. Click on the Password button.

3. Enter the desired password in the input box.    Click on OK.

4. Once the password is set and saved, every time the folder is opened the password will 
need to be entered before the folder will open.

To clear a password, perform steps 1 and 2 above, but instead of entering a password, 
simply leave the line blank and click on OK.    The password will then be cleared.

To lock people out of Windows completely, assign a password to the Sloop Manager window.  
Everytime Windows is run, the password will need to be entered correctly, otherwise 
Windows will be terminated.

Note that this password scheme is not unbreakable.    It will keep out most users, but a 
determined computer professional will be able to break it.

Related Topic
    Using the preferences command



Having folders open on startup

There are three ways in which you may have specified folders open automatically on 
Windows startup.    The first method is to select the 'Reopen folders' option in the global 
options dialog.    See Global option settings for information on this option.

The second method involves making use of the startup folder option.    By creating a folder 
named StartUp and placing the folder icons of the folders to be opened in this folder, either 
by moving or copying them, selected folders may be opened and available on Windows 
startup.    To use this option, simply create a folder named StartUp.    Any item, which 
includes folder and non-folder items, placed into this folder will be run on Windows startup.    
To have an item start as an icon on the desktop, simply select the 'Run minimized' option of 
the Properties dialog for that particular item.    To set the order of execution of items, simply 
arrange the items from left to right, with left being first, and save the folder.    By using this 
option, editing the WIN.INI file may be avoided entirely.

The third, and most    awkward method, involves editing the WIN.INI file.    First, open the 
SLOOPMAN.INI file with an editor such as Notepad.    Under the section [Folder list] find the 
folder(s) you wish to have opened on Windows startup.    Make a note of the DOS file name 
to the right of the equal sign.    Close this file and open WIN.INI.    On    the load= or run= lines
add the DOS file name you noted from the SLOOPMAN.INI file.    Save and close the WIN.INI 
file.    The next time you start Windows, the specified folders should open.



Associating programs with file extensions

Application programs may be associated with a particular file extension.    For example, 
Notepad may be associated with TXT files.    Executing a file with a program associated with 
its extension will cause the associated program to be run using the file as the data file.    For 
instance, if TXT is associated with Notepad, running the file readme.txt would cause Notepad
to run and load the file readme.txt.    Sloop Manager provides a command to form such 
associations.    It is similar to the File Manager command, with the exception that it is able to 
associate more than one program to an extension.

To associate a program, follow these steps:
1. Select the folder item whose filename's extension you wish to associate a program with.
2. From the Special menu, select the command Associate.
3. A dialog box will appear in which you may enter the name of the program you wish to 
associate or the program may be selected using the Browse button.
4. If an association already exists, the option to append the new association will be 
available.    To do so, click on the check box 'Append association'.        Click on OK.    This will 
cause the new association to be added to the list of programs associated with the selected 
extension.
5. If you wish overwrite the current association, or if there is no previous association, leave 
the check box unchecked and click on OK.
6. If you wish to view any other associations that have been previously set, click on the 
down arrow at the right of the input box.    A list of all other associations that have been set 
will appear.    To close the list, simply click on the down arrow again.

Notes:    If multiple programs have been assigned to an extension, whenever you execute an 
item with that file extension, a listbox will appear showing all the programs that have been 
associated with the extension.    Simply double-click on the program you wish to execute.

To remove a previously set association, follow steps 1 thru 3, but on step 3 click on the down
arrow at the right of the input box.    From the list of associations that appear, click on the 
association you wish to remove.    The program selection should appear in the input box.    
Click on OK and the association selected will be removed.



Using the Run command

1. Select Run from the File menu.

2. In the dialog box that appears, type in the command you wish to execute.    Or, use the 
browse button to select a file to be executed.

3. Click on OK.    The command entered will be executed.    By clicking on the 'Run minimized'
check box, the program will appear as an icon on the desktop.

Notes: The Run command stores the last twelve commands executed, throwing out 
duplicates.    When the Run command is selected, the last command entered using the Run 
command will automatically appear in the input box.    To execute it, simply click on OK.    To 
access the other eleven commands stored, click on the down arrow at the right of the input 
box.    A list will appear containing the other eleven commands.    Click on the command you 
wish to execute, and then click on OK.    The command will be run.


